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1. INTRODUCTION 
The FrontDoor Terminal, hereafter "the Terminal", is a sophisticated terminal emulator. It is the program you use when accessing bulletin 
board systems (BBS), Telnet services, and some other dial-up services. While the Terminal contains a number of advanced features, it is 
sufficient to be familiar with but a handful of them to use the Terminal. 

It is likely that you will encounter a number of unfamiliar terms. They will not be described in detail unless they are critical to complete 
the function described in a section. A small glossary is located at the end of this document. 

About this document 
When using the PDF viewer from Adobe, Acrobat Reader, this document is best viewed in 1024x768 (or higher) resolution. We realize 
that not everyone has access to hardware capable of such resolutions and apologize if the document appears hard to read on some displays. 
The bookmarks window (typically displayed to the left of the document window) can be closed to gain some display space for the 
document window. Furthermore, the View options Fit page and Fit width can be used to change the display of the document. We also 
recommend experimentation with the various display settings in the reader, in particular the Smooth text and monochrome images option 
(located under File.Preferences.General in the English language version of the reader). 
One, perhaps not so obvious, feature in the Acrobat Reader is the ability to jump "back" after having followed a link. To jump back, hold 
down the CTRL key and press - (minus). 

Version notation 
The following notations are used to indicate where features are supported differently by various versions of the software: 

[ML] Multi-line version; 
[SL] Single-line version (Shareware); 
[DOS] DOS version (see below); 
[!DOS] Any version other than the DOS version (see below); 
[OS/2] OS/2 version (see below). 

Executables 
Since this document intends to cover all available platform versions of the software, the following should be noted in regards to the name 
of the program executables: 

FD.EXE The name of the DOS executable; 
FD2.EXE The name of the OS/2 executable. 

Using this document 
This document is intended to be used as a reference guide. It makes the assumption that the reader understands some basics of the 
FrontDoor mailer, "FD" hereafter, and the general concept of a terminal emulator. The document does not attempt to explain any 
configuration issues in detail. For this purpose, the reader is advised to refer to the FrontDoor Administrator Guide. 
Throughout this document, references to options and menus in various FrontDoor programs, are made by using a reference to a menu path. 
These paths begin with the name of the top-level menu, followed by one or more menus or options, until the final destination has been 
reached. A few examples follow: 

Terminal.Miscellaneous.Protocol 
Modem.Hardware.Serial port 

If no reference is given to a specific program, FDSETUP is implied. 

Starting the Terminal 
To start the Terminal from the command prompt, you type FD /TERM at the prompt and press ENTER. If your computer responds with 
Bad command or filename (or a similar message), it is typically an indication that the Terminal has not been properly installed. If you 
know to which directory the Terminal was installed on your system, you can change to that directory and then repeat the previously 
described procedure. 

In graphical environments such as Windows and OS/2, the Terminal can also be configured with an icon to allow starting the program 
directly from that environment. 
To start the Terminal from FD, use the ALT+J shortcut. 
If you are experiencing problems when attempting to start the Terminal, please contact the system administrator.. 

http://www.adobe.com/
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Startup messages 
The following is a list of some common messages issued by the Terminal upon starting from the command prompt: 

Message FOSSIL driver not detected 
Description The Terminal could not detect the presence of a FOSSIL driver which is required for the Terminal to be able to 

communicate with the modem or other communications device attached to the computer. 
Notes [DOS] 

 
Message Unable to initialize communications hardware 
Description The Terminal could not open or initialize the communications hardware; typically the "COM port". The 

communications hardware may be in use by other applications or not properly closed by a previously used application. 
Notes [!DOS] 

 
Message Invalid or missing TASK setting 
Description The Terminal could not retrieve a valid task setting. This is configured through the TASK environment variable. 
Notes [ML] 

 
Message Invalid TZUTC setting 
Description The TZUTC environment variable has not been specified correctly 
Notes None 

 
Message FOSSIL revision 5 support required 
Description The Terminal successfully detected the presence of a FOSSIL driver. The FOSSIL driver does not, however, indicate 

support for the required level of capabilities. 
Notes [DOS] 

 
Message Frozen, waiting for semaphore to clear.. 
Description The Terminal has detected an applicable FDFREEZE semaphore and will remain "frozen" until the semaphore is no 

longer present. 
Notes To exit the Terminal immediately, press ALT+Q. 

 
Message Waiting (60s) for FDALIVE.nnn semaphore to clear 
Description The Terminal has detected an FDALIVE.nnn semaphore where nnn is a numerical value corresponding with the 

contents of the TASK environment variable. It will wait up to 60 seconds for the semaphore to be updated before 
resuming operation. If the semaphore is updated within 60 seconds, the Terminal will terminate; if the semaphore is 
not updated, the Terminal will continue to load. 

Notes If the detected FDALIVE.nnn semaphore is the result of a system crash, the Terminal can be forced to ignore its 
presence by pressing the SPACE. To exit the Terminal immediately, press ALT+Q. 
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2. THE BLANK SCREEN 
When the Terminal is successfully started, it will normally clear the screen and display its primary working screen; i.e. a blank screen. 
Unlike many other terminal emulation packages, the Terminal does not feature a status bar; nor any other static text in its working screen. 
If the Terminal is started from the command prompt (see "Starting the Terminal"), a window with product and license information will be 
displayed for a brief period of time; the Terminal will then attempt to initialize the communications device. 
If the Terminal does not display this screen, it is typically due to a configuration error. 
Once the Terminal has completed its startup sequence, it is ready to be used. Data entered from the local keyboard is transmitted to the 
communications device. Data received from the communications device is displayed on the screen. 
To leave the Terminal, press ALT+Q. 
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3. THE TERMINAL MENUS 
The pull-down menu system is accessed by using the shortcut corresponding to the desired menu. A good starting point is usually the File 
menu which is the menu invoked with ALT+F. To exit the menu system, simply press ESC. 
Most options available in the pull-down menu system can be directly accessed by using the shortcut listed to the right of the menu option; 
the options in the Line menu are, however, an exception to this. 
These shortcuts cannot be used while the menu system is displayed/active. The only shortcuts available while the menu system is active 
are those used to change the current pull-down menu (ALT+F, ALT+L, ALT+S, ALT+O, and ALT+H). 
The selection bar in menus is moved with UP and DOWN. Pressing the HOME key will move the selection bar to the topmost (available) 
field; pressing the END key will move the selection bar to the last (available) field, PGUP and PGDN generally move the selection bar 
one page up and one page down respectively. If a list or menu contains more entries than will fit on the screen, CTRL+PGUP and 
CTRL+PGDN can be used to move to the top and bottom, respectively, of the list/menu. 
To move between the top-level pull-down menus, the LEFT and RIGHT keys are used. 

File 
The contents of the File menu will now be described. The shortcut for the File menu is ALT+F as mentioned above. 

Upload files 
Invokes the upload function, used to transmit (upload) one or more files to the remote system. The Terminal will prompt for the file-
transfer protocol to be used, after which the file selection dialog is displayed. See "Uploading files" for more information about this 
function. 

! This function can also be used to update the modem firmware for modems with software configurable firmware. 

The shortcut for the Upload files function is ALT+F1. 

Download files 
Invokes the download function, used to receive (download) one or more files from the remote system. The Terminal will prompt for the 
file-transfer protocol to be used and where the received files should be stored on the local system. See "Downloading files" for more 
information about this function. 
The shortcut for the Download files function is ALT+F2. 

Transmit ASCII file 
This function is typically used when already written text, contained in an ASCII file on the local system, needs to be transmitted to a 
remote system as if it was entered from the keyboard. 
The Terminal will display the Transmit ASCII file dialog which contains options for how the line-termination sequence <CR><LF> 
(ASCII 13, ASCII 10) should be transmitted to the remote, how empty lines are to be handled, the character delay time, and the name of 
the file to read from. 
The character delay time is expressed in units of 1/100 seconds; the default is 20 (.2 seconds). Some situations may require a longer 
character delay time than that. If the final result of the ASCII transmission does not closely resemble the contents of the specified file, it is 
typically an indication that the character delay time setting is too low. 
Note that with the exception of line-termination sequences and empty lines (see above), the contents of the specified file are transmitted 
"as is" to the remote system. No filtering or conversion of data is made by the Terminal except for the possible use of translation tables 
(see "Translation tables"). 
The shortcut for the Transmit ASCII file function is ALT+A. 

Run script 
[ML] Allows a script to be invoked. Scripts are typically used when dialing remote systems to allow the Terminal to establish a connection 
when simply dialing the number of the remote system will not suffice, or when complex access authorization procedures are used by the 
called system. 
This function is primarily intended to allow a script to be invoked when a connection has already been established. For more information 
about scripts and the FrontDoor script language, refer to the Administrator Guide. 
There is no shortcut for this function. 

Macro management 
Invokes the keyboard macro management function used to maintain macro sets. A macro set is a collection of macro keys, also referred to 
as user keys. This function can also be used to select the active macro set. 
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A macro set consists of 20/24 (depending on the type of keyboard attached to the system) configurable user keys. The user keys are 
typically used to transmit a specific sequence of data to the communications device or remote system; such as a user name, a password, 
etc. The shortcuts for the user keys are SHIFT+F1 through SHIFT+F10 (F12) and CTRL+F1 through CTRL+F10 (F12). See "Keyboard 
macro manager" for more information about managing macro sets. 
Each entry in the phone directory (see below) can have a specific macro set assigned to it; when a connection is established after dialing an 
entry in the phone directory, the specified macro set is automatically loaded. The default macro set is configured in Terminal.Keyboard 
macros in FDSETUP. Macro sets 0-65535 can be configured and maintained from within the Terminal. 
The shortcut for the Macro management function is ALT+V. 

Profile management 
Invokes the profile management function used to maintain user profiles. A user profile is a collection of associated information about a 
given user; these profiles are primarily used for sessions negotiated using the interactive EMSI terminal protocol (IEMSI). 
This function can also be used to select the active profile. See "Profile manager" for more information about managing profiles. See 
"Interactive EMSI" for more information about Interactive EMSI. 
Each entry in the phone directory (see below) can have a specific profile assigned to it; when a connection is established after dialing an 
entry in the phone directory, the specified profile is automatically loaded. The default profile set is Default and this is configured in 
Terminal.IEMSI Profile in FDSETUP. Profiles 1-65535 can be configured and maintained from within the Terminal. 
The shortcut for the Profile management function is ALT+E. 

Command history 
Invokes the command history window. When text is manually entered and then terminated by pressing ENTER (i.e. to confirm the data to 
the communications device or remote system), the Terminal adds the text to a circular buffer referred to as command history. When the 
buffer used to store the command history becomes full, the Terminal will re-use the space occupied by the oldest entry. 
When this function is used to recall a sequence of data, the recalled data does not include the terminating/ending ENTER; the reason for 
this is to allow possible further input. 
If there is no history in the command history list, the Terminal will display No history when this function is invoked. 
Use the UP and DOWN keys to select the entry to be recalled from the history list; use ENTER to recall the currently highlighted entry. 
The shortcut for the Command history function is ALT+U. 

Editor 
Invokes the program specified in Terminal.Filenames and paths.Editor in FDSETUP. The Terminal will prompt for additional parameters 
to the program to be invoked. 
The FOSSIL driver is deactivated when the Terminal is temporarily suspended while the external program is running; when control is 
returned to the Terminal, the FOSSIL driver is reactivated/initialized. 

! This function can also be used to invoke an external file-transfer protocol or other external applications. 

The shortcut for the Editor function is ALT+I. 

DOS shell 
Invokes a temporary OS shell. From the OS shell, most operating system functions and external programs can be accessed. 
This function is most useful in pure DOS environments, or similar environments where it is not possible to start other programs without 
first exiting the currently running program. When the DOS shell function in the Terminal is used, a temporary copy of the OS is loaded 
and the Terminal is suspended. The DOS version of the Terminal can be (and is by default) configured  to maximize the amount of 
memory available in the temporary shell; this is referred to as the Terminal swapping itself out of memory. 
Once activities in the temporary OS shell have been completed, you must type EXIT and press the ENTER key to return to the Terminal. 
The DOS shell function is available from just about anywhere in the Terminal: including the various menus, dialog boxes, and input fields. 
The shortcut for the DOS shell function is ALT+Z. 

Leave Terminal 
Terminates the Terminal. When the Terminal is terminated, its log file and nodelist database will be closed, the FOSSIL driver and/or 
communications hardware will be deinitialized, and the program will exit with errorlevel ten (10) to indicate a user break (normal 
termination). 
The shortcut for this option is ALT+Q and is available in most screens, dialog boxes, and input fields. 
If the Terminal was invoked from FD by using the ALT+J shortcut, control is returned to FD as opposed to the Terminal exiting to the 
operating system. 
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Line 
The contents of the Line menu will now be described. The shortcut for the Line menu is ALT+L. 

BPS 
Allows the (DTE) speed at which the Terminal communicates with the communications device to be changed. Valid choices are 300, 
1200, 2400, 4800, 9600, 19200, and 38400 BPS. 
If the Modem.Hardware.Locked port setting in FDSETUP is configured as Yes, the speed cannot be changed; the Terminal will display 
Fixed instead of a speed figure if this is the case. It is common to lock the port when using high-speed modems and then configure the 
FOSSIL driver to a fixed speed (such as 57600 or 115200 BPS). 
There is no shortcut for this function. 

Data bits 
Specifies the number of databits that should be used when communicating with the communications device. This should normally be eight 
(8). Valid choices are seven (7) and eight (8). 
The Terminal will temporarily reset the data bits setting to eight (8) during file-transfers (this does not include the Transmit ASCII file 
function) and then restore the original setting upon completion. 
There is no shortcut for this function. 

Parity 
Specifies the type of parity that should be used when communicating with the communications device. This should normally be None. 
Valid choices are None, Odd, and Even. 
The Terminal will temporarily reset the parity setting to None during file-transfers (this does not include the Transmit ASCII file function) 
and then restore the original setting upon completion. 
There is no shortcut for this function. 

Stop bits 
Specifies the number of stop bits that should be used when communicating with the communications device. This should normally be one 
(1). Valid choices are one (1) and two (2). 
The Terminal will temporarily reset the stop bits setting to one (1) during file-transfers (this does not include the Transmit ASCII file 
function) and then restore the original setting upon completion. 
There is no shortcut for this function. 

Wraparound 
Determines whether or not the Terminal should place the cursor on a new line when it is positioned at the rightmost position of the screen 
and a character is received. This should be set to On in most situations. There are however VT100/VT52 applications that require this 
setting to be Off. When the emulation (see below) setting is manually changed to VT100, this setting is automatically set to Off. 

! This setting does not affect how the Terminal reacts to a <CR> or <LF> character being received. 

There is no shortcut for this function. 

CR expansion 
Determines how a received <CR> (ASCII 13) character should be processed by the Terminal. If set to CR, no expansion is made. If it is 
set to CR/LF, the Terminal will expand all received <CR> characters to <CR><LF>. 
There is no shortcut for this function. 

Local echo 
Some dial-up services do not echo (return) the characters sent by the Terminal; i.e. data entered from the local keyboard. It may be 
necessary to enable (Yes) this setting for such characters to be visible. 
If the remote system does echo the character entered locally, and this setting is enabled, the result will be duplicated text; e.g. 
HHEELLLLOO!!). This can also occur in an off-line (not connected) state if the communications device is echoing characters entered 
from the keyboard. 
There is no shortcut for this function. 
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Emulation 
Specifies the terminal emulation protocol that should be used by the Terminal when interpreting data received from the communications 
device (and thus the remote system). This is one of ANSI, VT100, VT52, and TTY emulation. 
TTY emulation features only primitive "terminal emulation" and does not support colors or cursor repositioning other than when <CR> 
and <LF> characters are received. 
When ANSI emulation is selected, the Terminal will automatically adjust the Allow AVT/0 sequences setting (see below) to reflect the 
Terminal.Miscellaneous.AVATAR/0+ setting in FDSETUP. AVT/0+ is a very efficient and fast terminal emulation protocol used by many 
BBS packages. Support for AVT/0+ sequences can be manually disabled (see below). 
For VT100 and VT52 emulation, the F1-F4 keys will transmit the sequences indicating the PF1-PF4 keys; F7 will transmit <ESC> 
(Escape, ASCII 27); F8 will transmit the keypad ENTER sequence (as will the ENTER key on the numerical keypad). 
There is no shortcut for this function. 

Hex dump mode 
Specifies the status of the Hex dump mode which is typically used for debugging purposes. When this mode is enabled (On), the Terminal 
will display the ASCII value of certain characters in hexadecimal notation rather than the character itself. 
Note that the Auto-Zmodem downloads function (below) will not function when this mode is enabled. 
There is no shortcut for this function. 

Translation tables 
Specifies the state of the translation tables used to translate data received from and data transmitted to the communications device; the 
setting is one of None, Config, and Latin1. 

None 
Instructs the Terminal that no translation of incoming and outgoing data should be performed. 

Config 
Instructs the Terminal to translate incoming and outgoing data as configured in Terminal.Xlat.In and Terminal.Xlat.Out. 

Latin1 
Instructs the Terminal to translate incoming and outgoing data from and to the ISO8859-1 (Latin1) character set. When this translation is 
performed, the current local code page (see "Code page") is used. 

! Latin1 translation is typically used when using the Terminal in 8-bit UNIX environments. 

There is no shortcut for this function. 

Auto-Zmodem downloads 
Determines if the Terminal should monitor data received from the communications device for the Zmodem receiver initialization 
sequence; indicating that a Zmodem transmitter is active on the remote system. 
If enabled (Yes), the Terminal will automatically invoke the Download files function with the Zmodem file-transfer protocol when the 
initialization sequence is detected. 
There is no shortcut for this function. 

Allow AVT/0 sequences 
Specifies that the Terminal should process received data that appears to be AVT/0+ (AVATAR/0+) terminal emulation sequences. Since 
AVT/0+ emulation is based on certain control characters, it may be desirable to disable support for such sequences if the remote frequently 
transmits such characters. 
There is no shortcut for this function. 

Clear on Form Feeds 
Determines whether or not the Terminal should clear the screen when a <FF> (form feed, ASCII 12) character is received from the 
communications device. 
There is no shortcut for this function. 
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Interactive EMSI 
Determines if the Terminal should attempt to negotiate an Interactive EMSI (IEMSI) session with the remote system to automatically 
transmit user information such as user name, user handle, password, etc. See "Interactive EMSI" below for more information about IEMSI. 
There is no shortcut for this function. 

Session 
The contents of the Session menu will now be described. The shortcut for the Session menu is ALT+S. 

Capture 
Allows received data to be captured to a disk file or printer (this is often referred to as logging data to disk). If the use of any type of 
translation tables has been enabled (see above), the data is translated before being captured. 
The Terminal will prompt for the name of the file or device to which captured data should be written. 

! The Terminal will not capture <NUL> (ASCII 0) characters; if the current terminal emulation is set to VT100 or VT52, no characters with an ASCII 
value below <SPACE> (ASCII 32) will be captured. 

The shortcut for the Capture function is ALT+C. 

Conversation mode 
Invokes the conversation mode, or full-screen chat, function. This is a split-screen interface where data received from the communications 
device is displayed in the upper section of the screen and data entered from the local keyboard is displayed in the lower section of the 
screen. 
If an IEMSI session (see above) has been established with the remote system, the Terminal will monitor received data for a request to 
automatically invoke and terminate the conversation mode function. 

! Note that while the conversation mode function is active, no functions other than those listed at the bottom of the screen are available; with the exception 
of keyboard macros and the DOS shell function. Furthermore, capturing and any special (non-TTY) terminal emulation is temporarily suspended. 

The shortcut for the Conversation mode function is ALT+N. 

Dial 
Invokes the nodelist dial function which allows a remote system listed in the nodelist database to be dialed. The Terminal will prompt for 
an address to search for in the nodelist database. See "Specifying addresses" for more information about this. 
The current settings (emulation, macro set, etc) will be used when a connection with the remote system has been established. If system-
specific settings are required, the phone directory (see below) should be used as it allows a number of settings to be customized for a given 
remote system. 

! Note that this function is disabled if the nodelist database is not present. 

The shortcut for the Dial function is ALT+D. 

Manual dial 
Invokes the manual dial function which is simply a telephone number prompt. If the manual dial telephone number prompt is completed, 
the Terminal will attempt to dial the specified number; the number will be sent to the communications device without further translation. 
The current settings (emulation, macro set, etc) will be used when a connection with the remote system has been established. If system-
specific settings are required, the phone directory (see below) should be used as it allows a number of settings to be customized for a given 
remote system. 
The shortcut for the Manual dial function is ALT+M. 

Disconnect 
Disconnects the call in progress (if any). 
The shortcut for the Disconnect function is ALT+X. 

Phone directory 
Invokes the phone directory manager used to maintain the terminal phone book. Entries in the phone directory can be customized to allow 
certain options to be automatically adjusted when a connection with a given system is established. The phone directory manager is 
described in a separate section (see "Phone directory manager"). 
The shortcut for the Phone directory function is ALT+P. 
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Reset timer 
Resets the on-line timer to zero. The on-line timer is automatically reset when a new connection is established. Once a connection is 
terminated, the Terminal displays the amount of time elapsed between the connection being established and the connection being 
terminated. 
The current on-line timer can be viewed in the Options menu (see below) when a connection has been established. 
The shortcut for the Reset timer function is ALT+R. 

Scroll back buffer 
Invokes the scroll back buffer manager which can be used to view data that has scrolled off the screen. The scroll back buffer manager 
allows the contents of the buffer to be saved to disk (F3 and F4); to leave the scroll back buffer manager, press ESC. 

! Note that the Terminal may automatically clear the contents of the buffer if there is insufficient memory available when the phone directory manager is 
invoked. 

The shortcut for the Scroll back buffer function is ALT+B. 

Send BREAK 
Instructs the Terminal to transmit a (short) BREAK signal to the communications device. How the communications device handles the 
BREAK signal depends on its configuration. Many communications devices, in particular modems, can be configured to clear its internal 
buffers upon receiving a BREAK signal. 
The shortcut for the Send BREAK function is ALT+W. 

Clear screen 
Clears the screen and positions the cursor in the upper left-hand corner. 
The shortcut for the Clear screen function is ALT+J. 

Initialize modem 
[ML] Instructs the Terminal to transmit the various modem initialization strings to the communications device; these strings are configured 
in Modems.Command strings.Init-1 through Init-3, Terminal.Miscellaneous.Init, and Modem.Command strings.TermInit (and transmitted 
in that order). 
The Terminal does not attempt to interpret any possible response messages from the communications device. 
The shortcut for the Initialize modem function is ALT+Y. 

Options 
The contents of the Options menu will now be described. The shortcut for the Options menu is ALT+O. 

Raw mode 
Shows the state of the raw keyboard mode, or raw mode for short. 
The IBM PC keyboard generates two characters for every key you press. The first character is called the ASCII code, and the second 
character is called the scan code. Only the ASCII code is transmitted to the remote system by default. There are, however, some situations 
which require the Terminal software to transmit both codes. The AVATAR emulation protocol and the Doorway programs both require 
the complete codes (two characters) to identify certain keys; function and cursor keys in particular. 
The shortcut for the Raw mode function is SCROLLLOCK. An alternative to the SCROLLLOCK key is ALT+=; this shortcut may not, 
however, work in all environments. ALT+= refers to the key immediately to the left of the BACKSPACE key on non-US/UK keyboards. 
Raw mode can also be enabled when the remote system transmits a specific sequence that instructs the Terminal to enter raw mode. 
Whether or not the Terminal honors the raw mode sequence is controlled by the Terminal.Miscellaneous.Auto DW Mode setting in 
FDSETUP. 
Once raw mode has been enabled, you cannot reach any of the Terminal's regular functions by using the keyboard until raw mode is 
disabled. If mouse support is enabled (default), you can invoke the menu (by clicking both buttons on a two-button mouse or the center 
button on a three-button mouse) and thus reach most functions. 

! The ALT+= shortcut was added in addition to SCROLLLOCK to allow raw mode to be enabled in operating environments where SCROLLLOCK is already 
used for some other function. One such environment is DESQview/X. This means that the ALT+= keyboard sequence cannot be transmitted in raw mode. 
It should also be noted that regardless of the ScrollLock LED on the keyboard, the Options menu should correctly reflect the proper state of 
SCROLLLOCK. 
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Numerical keypad 
Shows the state of the numerical keypad and the numerical keypad mode for VT52/VT100 emulation. See "Keypad modes" for additional 
information about this. 
The shortcut for the Numerical keypad function is NUMLOCK. 

! When the remote system (host) requests that the Terminal enters numerical application keypad mode, the Terminal automatically enables NumLock. On 
extended (101/102) keyboards, this will also enable the NumLock LED. The NumLock LED on IBM-PC (standard) keyboards will not change by doing 
this. 
It should also be noted that versions other than the DOS version may not be able to change the NumLock LED depending on the operating system. 
The Options menu should, however, correctly reflect the proper state of NumLock. 

Cursor key mode 
Shows the state of the cursor key mode; this is only applicable to VT52/VT100 emulation. See "Keypad modes" for additional information 
about this. 
The shortcut for the Cursor key mode function is ALT+F10. 

Scroll back used 
Shows information about the scroll back buffer. 
[DOS] The figures represent the amount of memory used and the maximum amount of memory for the scroll back buffer respectively. 
[!DOS] Only the amount of memory currently used for the scroll back buffer is displayed. 
There is no shortcut for this function. 

Capture 
Shows whether or not capturing (see "Capture" above) is active. 
There is no shortcut for this function. 

On-line 
Shows whether or not a connection is active. 
There is no shortcut for this function. 

Time on-line 
Shows the duration of the current connection (if any). 
There is no shortcut for this function. 

Speed 
Shows the speed of the current connection (if known). 
There is no shortcut for this function. 

Code page 
Shows the currently active code page used by the Terminal. This is only used when data translation is set to Latin1 (see "Translation 
tables"). 
There is no shortcut for this function. 

Help 
The contents of the Help menu will now be described. The shortcut for the Help menu is ALT+H. 

Current macro set 
Displays the 20/24 (depending on the type of keyboard attached to the system) configurable user keys and allows one to be selected and 
transmitted by moving the selection bar to the desired key. 
The user keys are typically used to transmit a specific sequence of data to the communications device or remote system; such as a user 
name, a password, etc. See "Macro management" for more information about configuring macro sets. 
The shortcuts for the user keys are SHIFT+F1 through SHIFT+F10 (F12) and CTRL+F1 through CTRL+F10 (F12). 
The shortcut for the Current macro set function is ALT+K. 
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Raw mode 
Displays some brief information about the "raw" keyboard mode. See "Raw mode" (Options menu) for more information about this. 
There is no shortcut for this function. 

Numerical keypad 
Displays some brief information about the numerical keypad when the numerical keypad mode is active. See "Numerical keypad" (Options 
menu) for more information about this. 
There is no shortcut for this function. 

Program notice 
Displays program and license information. 
There is no shortcut for this function. 



FrontDoor Terminal User Guide

Uploading files Page 17

4. UPLOADING FILES 
The Upload files function (ALT+F1) in the File (ALT+F) menu is used to transmit (upload) one or more files to the remote system; it can 
also be used to update the modem firmware for modems with software configurable firmware. 
The Terminal will first prompt for the file-transfer protocol to be used. If one is specified, the Terminal will display the transmit files entry 
screen. The transmit files browser can be invoked by pressing ENTER in the entry field if it is empty, or by specifying a filemask 
containing wildcards (? and *). 
The Zmodem file-transfer protocol should be used where possible as it is by far the most efficient and tolerant protocol of the internally 
available protocols. 

! The transmit files browser cannot be invoked for the Xmodem file-transfer protocol; this protocol only allows one file at a time to be transmitted to the 
remote system or communications device. 

The top section of the browser shows the currently selected directory and the files contained in it. This section is used to select the files to 
transmit. The bottom section of the browser shows a list of files that have been selected for transmission; entries can be removed from the 
bottom section. TAB is used to switch between the two sections. 
To select the currently highlighted file from the top section, press the SPACE key. The selected file should immediately appear in the 
bottom section. If the file does not appear, it is an indication that there is insufficient memory available to add the file; should this happen, 
you can either switch to the bottom section and remove some files, or restart the Terminal and then attempt to use this (Upload files) 
function again; though doubtful, it is possible that clearing the scroll back buffer will make a sufficient amount of memory available for 
this function to operate. 
If you press the ENTER key on a directory entry (indicated by a trailing \) in the top section, the browser will switch to that directory. If 
you press the ENTER key on a drive entry (indicated by [- and -] surrounding the drive letter) in the top section, the browser will switch to 
that drive. 
When the desired files have been selected, press F10 from the browser window (either the top section or the bottom section). To abort the 
function, press ESC. 
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5. DOWNLOADING FILES 
The Download files function (ALT+F2) in the File (ALT+F) menu is used to receive one or more files from the remote system. 
The Terminal will first prompt for the file-transfer protocol. If one is specified, the Terminal will display the receive files entry screen. The 
Zmodem file-transfer protocol should be used where possible as it is by far the most efficient and tolerant protocol of the internally 
available protocols. 
Depending on the selected protocol, the Terminal requires either a valid path or a complete filename to be specified. For the Xmodem file-
transfer protocol, a complete filename must be specified; furthermore, only one file at a time can be received using this protocol. For other 
protocols, a valid path must be specified; the Terminal will use applicable information from the remote system about the file to be 
received. 

! When specifying a path, the directory browser can be invoked by pressing F10. 

It should be noted that the Terminal cannot be configured to allow the reception of an identical (existing) file. For the Zmodem and 
SEAlink file-transfer protocols, the Terminal will compare the time, date, and size of an existing file with the same name as the one being 
sent by the remote system; if the file being sent is considered to be identical to an existing file, the Terminal will request that the remote 
system skips (does not send) the file and proceed to the next file if any. 

Auto-Zmodem downloads 
When the Zmodem file-transfer protocol is used, the Terminal can receive files without manual intervention by simply instructing the 
remote system to begin transmitting the files. This requires that the auto-Zmodem download setting (see "Auto-Zmodem downloads") in 
the Line menu is enabled (Yes). 
When the auto-Zmodem function is used, the Terminal will use the last path specified in the receive files entry screen. If the receive files 
entry screen has not yet been invoked, the Terminal will default to the directory specified in Terminal.Filenames.Download. 



FrontDoor Terminal User Guide

Keyboard macro manager Page 19

6. KEYBOARD MACRO MANAGER 
The macro manager is used to maintain the terminal keyboard macros (see "Macro management"), or keyboard macro sets. A macro set 
consists of 20/24 (depending on the type of keyboard attached to the system) configurable user keys. The user keys are typically used to 
transmit a specific sequence of data to the communications device or remote system; such as a user name, a password, etc. 
The default macro set is configured in Terminal.Keyboard macros in FDSETUP. Macro sets 0-65535 can be configured and maintained 
with the keyboard macro manager; invoked with the ALT+V shortcut. 
The keyboard macro sets are stored in the TERMKEYS.FD file in the SYSTEM directory. Keyboard macro sets may contain special 
characters that are expanded by the Terminal when a given macro sequence is transmitted to the communications device or remote system. 

Navigating 
If one or more macro sets have been created from within the Terminal, the keyboard macro manager will display the currently active 
macro set (if any); if the default macro set is the active set, the macro manager will initially display macro set zero (0); i.e. the first macro 
set configured from within the Terminal. 
The LEFT and RIGHT keys can be used to move to the previous and next macro set, respectively. The HOME and END keys can be 
used to move to the first and last macro set, respectively. To locate a specific macro set by its number, the Find (F5) function can be used. 

Adding macro sets 
To add a new keyboard macro set, press INS (Insert). An entry screen will be displayed where the contents of the new macro set can be 
configured; it is possible, but not recommended, to save an keyboard macro set even though no data has been entered. 
To copy an existing entry, select (display) the macro set that should be copied and press F10 (instead of pressing INS). 
Most of the available special sequences are displayed in the entry screen, some notes regarding these are, however, mentioned below. 

Clearing all fields 
The F9 key can be used to clear the contents of the macro set. 

Importing the default macro set 
The contents of the default macro set (see above) can be imported into a macro set being created by using the Import default set function 
(F6). Using this function will replace the contents of the macro set being created with the contents of the default macro set. 

Special characters 
The following character sequences can be used in macro sets to perform specific functions. 
~~ Literal ~
~| Literal |
| <CR>
~B <TAB>
~! One (1) second pause
~P The contents of the password field in the current IEMSI profile (see "Profile management" and

"Profile manager").

 
It is also possible to insert special characters by using CTRL+P followed by a numerical sequence entered on the numerical keypad; e.g. 
to add the <FF> (ASCII 12) character, press CTRL+P, and then hold down the ALT key and enter the digits 1 and 2 (12) on the numerical 
keypad before releasing the ALT key. 

Saving a macro set 
Press F10 to save the new macro set. 

Discarding changes to a macro set 
Press ESC to discard the new macro set. 

Editing macro sets 
Editing macro sets is similar to adding new macro sets. Press F4 to edit the currently displayed macro set. For more information about the 
various options, see "Adding macro sets". 
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Removing macro sets 
It is not possible to remove a single, specific macro set. To remove all macro sets configured from within the Terminal, press DEL 
(Delete); the Terminal will prompt you to confirm that it should remove all macro sets. 
To remove the contents of a specific macro set, use the Edit function (F4), clear all the fields (F9), and then save the macro set. 

Selecting a macro set 
To select the currently displayed macro set for use, press ENTER. To select the default macro set for use, press F6. 

Exiting 
Press ESC to close the profile manager window. 
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7. PROFILE MANAGER 
The profile manager is used to maintain (IEMSI) user profiles. A user profile is a collection of associated information about a given user; 
these profiles are primarily used for sessions negotiated using the interactive EMSI terminal protocol (IEMSI). This function can also be 
used to select the active profile. 
The default profile is configured in Terminal.IEMSI Profile in FDSETUP. Profiles 1-65535 can be configured and maintained with the 
profile manager; invoked with the ALT+E shortcut. 
The user profiles are stored in the TERMPROF.FD file in the SYSTEM directory. 

Navigating 
The profile manager will initially display the currently active profile. 
The LEFT and RIGHT keys can be used to move to the previous and next profile, respectively. The HOME and END keys can be used 
to move to the first and last profiles, respectively. To locate a specific profile set by its number, the Find (F5) function can be used; the 
number of the default profile is zero (0). 

Adding profiles 
To add a new profile, press INS (Insert). An entry screen will be displayed where the contents of the new profile can be configured; it is 
possible, but not recommended, to save a profile even though no data has been entered in the Name, Handle, and Password fields. 
To copy an existing entry, select (display) the profile that should be copied and press F10 (instead of pressing INS). 
Most of the available profile settings are interpreted in a similar manner by BBS software and other on-line applications supporting the 
IEMSI protocol. 
Name is typically the real user name; e.g. John Doe. 
Handle, where supported, is typically a short-form name of the real user name or a nickname; e.g. JD. 
Password is the password required to access the system. 
For the remaining settings, please consult the user guide or instructions of the on-line system for more information. Some of the remaining 
settings are not supported by certain BBS software. 

Clearing all fields 
The F9 key can be used to clear the contents of the profile. 

Importing the default macro set 
The contents of the default profile (see above) can be imported into a profile being created by using the Import default profile function 
(F6). Using this function will replace the contents of the profile being created with the contents of the default profile. 

Saving a profile 
Press F10 to save the new profile. 

Discarding changes to a profile 
Press ESC to discard the new profile. 

Editing profiles 
Editing profiles is similar to adding new profiles. Press F4 to edit the currently displayed profile. For more information about the various 
options, see "Adding profiles". 

Removing profiles 
It is not possible to remove a single, specific profile. To remove all profiles configured from within the Terminal, press DEL (Delete); the 
Terminal will prompt you to confirm that it should remove all profiles. 
To remove the contents of a specific profile, use the Edit function (F4), clear all the fields (F9), and then save the profile. 

Selecting a profile 
To select the currently displayed profile for use, press ENTER. To select the default profile for use, press F6. 
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Exiting 
Press ESC to close the profile manager window. 
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8. PHONE DIRECTORY MANAGER 
The phone directory manager is used to maintain the terminal phone book. The phone book entries are stored in the TERMPHON.FD file in 
the SYSTEM directory. Entries in the phone directory can be customized to allow certain options to be automatically adjusted when a 
connection with a given system is established. 
The phone directory manager list is divided into six columns. From left to right, they are: description, telephone number, baudrate, 
terminal emulation protocol, file-transfer protocol, and some optional indicators (not present on all entries). 
The current connection state - Offline or Online - is displayed to the right on the top window frame. 

Navigating 
The selection bar is moved with UP and DOWN. The HOME key will move the selection bar to the topmost (of those displayed) entry; 
and the END key will move the selection bar to the last (of those displayed) field. CTRL+PGUP and CTRL+PGDN will move to the 
first and last entry in the list, respectively. 
The incremental search function can also be used to move the selection bar. It works by matching text that you type against a description. 
It first attempts to search from the current position of the selection bar towards the end of the list. If no match is made, the search is 
restarted from the top of the list, until the position of the selection bar is reached, in which case no match was made. 
The search criterion that the incremental search function works with will be displayed to the left on the bottom window frame. 

Description 
This is the description of the phone book entry; this field typically contains the name of the remote system. 

Telephone number 
The telephone number to be dialed to establish a connection with the remote system. The contents of this field is sent without further 
translation to the communications device. 
If the entry has been configured to use a script to establish a connection with the remote system, the name of the script is shown in this 
column instead of the telephone number. 

Baudrate 
The (DTE) BPS rate to which the Terminal should configure the communications port when the entry is selected to be dialed. This 
contents of this field is ignored (and cannot be edited) if the Modem.Hardware.Locked port setting in FDSETUP is configured as Yes. 

Emulation protocol 
The default terminal emulation protocol that should be used when a connection is established with the remote system. This is one of ANSI, 
VT100, VT52, and TTY. See "Emulation" for more information about the various terminal emulation protocols. 

File-transfer protocol 
The default file-transfer protocol that should be used when a connection is established with the remote system. This is one of Zmodem, 
SEAlink, Telink, and Xmodem. The Zmodem file-transfer protocol should be used where possible as it is by far the most efficient and 
tolerant protocol of the mentioned protocols. 

Optional indicators 

L 
Indicates that the entry has the CR expansion (see "CR expansion" above) setting enabled (On).  

X 
Indicates that the entry has the Config translation tables (see "Translation tables" above) configured. 

Q 
Indicates that the entry is queued for dialing (see "Dialing"). 

#### (small square) 
Indicates that the entry has been marked to be removed (see "Removing entries"). 
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Adding entries 
To add a new entry to the phone book, press INS (Insert). An entry screen will be displayed where a number of fields should be 
configured; it is, however, possible to save an entry even though no data has been specified for the description (name) and number 
(telephone number) fields. 
To copy an existing entry, place the selection bar on the entry to be copied and press F10 (instead of pressing INS). 
[DOS] A maximum of 400 entries can be kept in the Terminal's phone book. [!DOS] A maximum of 1000 entries can be kept in the 
Terminal's phone book. 
As most options in the entry screen correspond to various settings and options already described, they will not be described in detail here. 
Some notes worth mentioning are, however, listed below. 

Clearing all fields 
The F9 key can be used to clear the various fields. 

Random password 
To use the Random password function, press F8. The Terminal will generate an eight-character sequence consisting of characters A-Z, 1-9 
and set the contents of the Password field to the generated sequence. 

BPS 
The contents of the BPS field cannot be modified if the Modem.Hardware.Locked port setting in FDSETUP is configured as Yes. 

IMPORT 
The IMPORT function allows the applicable data from an entry in the nodelist database to be imported. See "Specifying addresses" for 
more information about specifying addresses to access entries from the nodelist database. 

Saving an entry 
Press F10 to save the new entry. 

Discarding a new entry 
Press ESC to discard the new entry. 

Editing entries 
Editing phone book entries is similar to adding new entries. Press F4 to edit the currently highlighted entry. For more information about 
the various fields and options, see "Adding entries". 

Removing entries 
To remove the currently highlighted entry, press DEL (Delete). This will toggle the deletion flag for the currently highlighted entry; the 
deletion flag is indicated by a small square (#). Entries marked for deletion will be removed when the phone book window is closed or 
when the Sort/Purge function is used. 

Sorting entries 
The Sort/Purge function is used to sort the entries in the phone book. Entries will be sorted in ascending order based on the contents of the 
description field. Using the Sort/Purge function will result in entries marked for deletion (see above) being removed from the phone book. 

Dialing 
To select an entry for immediate dialing, press ENTER when the selection bar is positioned on the desired entry. When an entry is 
selected for immediate dialing, the Terminal will add the entry to the dialing queue (indicated by a Q) and then process the queue starting 
with the selected entry. 
If the dial attempt did not result in a connection, the Terminal will process the next entry in the queue (if any) until a connection is 
established or the dial function is manually aborted. When the last entry in the queue is reached, the Terminal will recycle to the first entry. 
If a connection is established, the phone book window will be closed automatically. 
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Managing the dialing queue 
To toggle the queue flag for the currently highlighted entry, press SPACE. To remove all entries from the dialing queue, press F6 (this 
does not remove any entries from the phone book). 

Exiting 
Press ESC to close the phone book window. 
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9. SPECIFYING ADDRESSES 
For certain functions, the Terminal will prompt for an address to be specified; i.e. a nodelist address. There are a number of ways to 
provide the Terminal with this information. 
The most obvious way is to specify the address manually; this is also the fastest method, but requires that you know the address. 
The FrontDoor nodelist database is much like a phone directory listing. The Terminal can be instructed to look-up systems in the database, 
and then copy information from the database to the input field in which the address should be entered. These look-ups can be made by 
providing partial or complete search criteria to the Terminal. When you provide partial search criteria to the Terminal, something called a 
browser is invoked. 
There are two primary browsers in the Terminal: The nodelist browser and the userlist browser. The former is used to browse the nodelist 
sorted on the various components of an address (Zone, Net, Node, and Point), the latter is used to browse the nodelist sorted on names (last 
names) of users (typically, system operators). 

The userlist browser 
The userlist browser is invoked by entering a partial system operator name when prompted to specify an address. For example, to invoke 
the userlist browser, you could type AN (or an) and then press the ENTER key. If the Terminal could locate one or more system operators 
in the nodelist with a last name starting with the letters AN, it will display these in a list for you to choose from. If you want to change the 
search criteria – for example to make it more specific – when the Terminal has displayed its list, simply press the ESC key and change AN 
to something else, and press ENTER again. 

The nodelist browser 
The nodelist browser can be invoked by simply pressing ENTER when the entry field is empty or by specifying an address search mask. 
An address search mask is made up of one or more address components, followed by a question mark (?). The only effect the address 
search mask has is to determine where in the nodelist database the Terminal starts displaying from. 

Address search masks 
:? 

Starts by displaying all zones in the nodelist 
Z:? 

Starts by displaying all nets in zone Z; e.g. 255:? 
Z:N/? 

Starts by displaying all nodes in zone Z, net N; e.g. 255:3046/? 
Z:N/D.? 

Starts by displaying all points of the server/boss system Z:N/D; e.g. 255:3046/10.? 
? 

Starts by displaying all nodes in the net of your address. This is the same as pressing ENTER in an empty field. 

NAMES.FD 
This is the name of a text (ASCII) file located in the FrontDoor SYSTEM directory that, if present, allows you to maintain a list of 
frequently used names and (optionally) addresses. This file is not required for the Terminal to function, but if used properly it can save a 
lot of typing and time. 
Depending on how your system is configured, you may not have sufficient access to edit this file. But if you do, it can be edited by using a 
normal text editor. The format of the file is described in the Administrator Guide. 
To invoke the NAMES.FD browser, simply type an asterisk (*) in the address entry field and press ENTER. If you append data after the 
asterisk, that data will be used as the initial search criteria for the incremental search (described below). The first field in this file is used as 
a tag (description); i.e. if the first entry’s tag is "doe", and you enter *doe in the recipient name field, the Terminal will find a match on the 
first line and immediately exit. If there is more than one line starting with the same text, the Terminal will position the selection bar on the 
first match and expect you to choose an entry from the list. 

! Unlike when you invoke the userlist browser, the Terminal will not limit the list to only contain those entries matching the text entered in the recipient 
name field. 

Searching while browsing 
You can also move the selection bar in the various browsers to the desired entry by using the incremental search function. Once you have 
become familiar with this function, it is usually the fastest way to select an entry while browsing. 
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The incremental search function works by matching text that you type against a name (last name) or an address. It first attempts to search 
from the current position of the selection bar towards the end of the list. If no match is made, the search is restarted from the top of the list, 
until the position of the selection bar is reached, in which case no match was made. 
The search criteria that the incremental search function works with will be displayed to the left on the bottom window frame. 
If you enter a digit (0-9) as the first character, the incremental search function attempts to match it to an address. Note that in the nodelist 
browser, the entire recipient address is not displayed in the list. The Terminal will attempt to match your incremental search criteria with 
what is displayed in the list. 
If you enter any non-digit as the first character, the incremental search function attempts to match it against a name in similar way to that 
described above. Keep in mind that the incremental search function attempts to match the criteria you provide with the last name of the 
recipient. 
It may sometimes be necessary to correct a typing mistake in the search criteria; if you are trying to locate a system operator with the last 
name Johansson but have typed johant, simply press BACKSPACE once to erase the t character and then resume typing. Note that if no 
matches could be made with johant, the Terminal will have reset the search string to the last character entered, in this case a t, making it 
impossible to correct the mistake by using BACKSPACE. 
If there are several entries in the list with a similar recipient name or address, you can force the incremental search to display the next 
match without further typing; if you are trying to locate a recipient with the last name Johansson and there are several recipients in the list 
with that last name, simply type johansson and then use TAB to move to the next match. 

Selecting 
Press ENTER to select the currently highlighted address and return to the address entry field. 

Exiting 
Press ESC to abort the browser and return to the address entry field. 
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Appendix A: GLOSSARY 
 

Active field Certain input screens, such as the message header dialog box, contain a number of input fields where you enter 
data. The active field is the field that is currently being used to store the data that you enter. 

Address The unique combination of Zone:Net/Node.Point, identifying an individual site (system). 
AKA Alternative address ("Also Known As"). 
ARQ Automatic Repeat Request; a general term for error control protocols which feature error detection and 

automatic retransmission of defective blocks of data. 
ASCII American Standard Code for Information Interchange; used to represent letters, numbers, and special characters 

such as $, !, and /. 
Auto Answer A feature of most modems, allowing them to answer inbound calls automatically, without the intervention of 

software or other hardware. 
AVATAR An flexible and extremely fast terminal emulation protocol designed by George A. Stanislav. The Terminal 

supports the AVATAR/0+ (AVT/0+) level of this protocol. AVATAR stands for Advanced Video Attribute 
Terminal Assembler and Recreator. 

BBS See Bulletin Board System 
Bit rate The number of binary digits or bits transmitted per second (BPS). Communication channels using telephone 

links are established at set bit rates, commonly 9600, 14400, 28800, and 33600 BPS. 
BPS The bits (binary digits) per second rate. 
Bulletin Board System A Bulletin Board System, or BBS for short, is a system to which users can connect via a dial-up connection, a 

Local Area Network or via the Internet. It often consists of different areas, e.g. message groups, file areas, on-
line games, and chat rooms. 

Caller ID Information identifying the calling party. This is typically generated by the communications/telephony network 
for use by devices and applications. 

Carrier detect A control signal line of the RS-232C standard interface typically used to indicate that two devices (such as 
modems) have established a connection. 
Forced carrier is the term used to describe the case when a communications device has been configured to 
always assert carrier detect, regardless of the true state of the connection; this is not desirable when using the 
device in conjunction with FD. 

CD See Carrier detect 
Clear to send A control signal line of the RS-232C standard interface indicating that the communications device (such as a 

modem) is ready to receive data from the data terminal (computer). The clear to send signal is used to 
implement hardware flow control between the data terminal and the communications device (CTS/RTS 
handshaking). 

CPS Characters per second; an expression used to measure the speed of file and data transfers. 
CTS See Clear to send 
Data communication 
equipment 

Equipment used to establish and control a data link between two geographical locations, often by using the 
telephone network. This is typically a modem or ISDN adapter. 

Data terminal 
equipment 

The device that generates/creates or is the final destination of data; typically a computer. 

Data terminal ready A control signal line of the RS-232C standard interface indicating that the data terminal (computer) is ready to 
use a communications device. This signal is often used to instruct a communications device to terminate a 
connection (hang-up). 

DCD See Carrier detect 
DCE See Data communication equipment 
DTE See Data terminal equipment 
DTR See Data terminal ready 
E-Mail Electronic mail. 
EMSI Electronic Mail Standard Identification. A standard describing a method by which two mailers (such as FD) 

determine which features should be used to exchange mail and files; EMSI is a very flexible handshake 
protocol favored by FD over FTS-1 and FTS-6 to negotiate mail sessions with other systems. 

Flow control A mechanism that compensates for differences in the flow of data input to and output from a device, such as a 
modem. 

FOSSIL An acronym for Fido, Opus, SEAdog Standard Interface Layer. This refers to a driver, or an interface to a 
driver, providing some basic functions based around communications and the IBM PC interrupt 14H vector. 

FTS-1 FidoNet Technical Standard #1. A standard describing a method by which two mailers (such as FD) determine 
which features should be used to exchange mail and files; this is often called the FTS-1 handshake protocol. 
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FTS-6 FidoNet Technical Standard #6. A standard describing a method by which two mailers (such as FD) determine 
which features should be used to exchange mail and files; this is often called the FTS-6 or YooHoo handshake 
protocol. FTS-6 is more flexible and faster than the FTS-1. 

Hardware flow control Flow control implemented by means of using hardware signals such as CTS and RTS. 
IEMSI Interactive EMSI. Used to automatically logon with a Terminal program to an interactive service such as a BBS. 
ISDN Integrated Services Digital Network;  ISDN is an application of digital technology that provides end-to-end 

digital service over the public communications network. ISDN was designed to integrate the transmissions from 
a variety of devices (computers, telephones, and fax machines) into one digital network. 

LAN Local Area Network. 
A LAN is often used to connect a number of computers at an office with each other, to make it possible to share 
resources such as disk drives, modems, and printers. 

Mailer A program responsible for sending, receiving, storing, and forwarding of mail. FD is the mailer in the 
FrontDoor package. 

Modem MODulator/DEModulator; a device that transmits and receives data through a communications channel such as 
radio or telephone lines. It modulates, or transforms, digital signals from a computer into the analog form that 
can be carried successfully on a telephone line. It also demodulates signals before passing them on to the 
receiving computer. 

Network Address See Address 
Parity An error-detection method that checks the validity of a transmitted character. Parity checking has been 

surpassed by more reliable and efficient forms of block-checking, including Xmodem-type protocols and the 
ARQ protocol. The same type of parity must be used by two communicating computers, or both may omit 
parity. When parity is used, a parity bit is added to each transmitted character. The bit's value is 0 or 1, to make 
the total number of 1's in the character even or odd, depending on which type of parity is being used (Odd, 
Even, Mark, Space, None, etc). 

Primary Address The first address configured in FDSETUP (Global.Address.Address.Main). 
Primary AKA See Primary Address 
Protocol A system of rules and procedures governing communications between two or more devices or programs. 

Protocols vary, but communicating devices and programs must follow the same protocol in order to exchange 
data. The format of the data, readiness to receive or send, error detection, and error correction are some of the 
operations that may be defined as protocols. 

Request to send A control signal line of the RS-232C standard interface indicating that the data terminal (computer) is ready to 
receive data from the communications device (such as a modem). The request to send signal is used to 
implement hardware flow control between the data terminal and the communications device (CTS/RTS 
handshaking). 

RTS See Request to send 
SEAlink A sliding-windows 8-bit only file transfer protocol based on Xmodem, developed by System Enhancement 

Associates (SEA). 
Software Flow Control See XON/XOFF 
Start/Stop bits The signaling bits attached to a character before the character is transmitted during asynchronous transmission. 
Undialable A system which is listed in the FD undialable manager with three check marks (">>>") is said to be undialable; 

i.e. FD will not call such a system. The concept of undialable systems is intended to protect against repeated 
failures to establish a successful mail session with a given remote system. 

WAN Wide Area Network. 
A WAN is used to connect computers at different locations to each other. 

Word length The number of bits in a data character other than parity, start, or stop bits. 
XC See Crossposting 
Xmodem The first of a family of error control software protocols used to transfer files between computers. Xmodem is in 

the public domain and was originally designed by Ward Christensen in 1977. 
XON/XOFF Standard ASCII control characters used to tell an intelligent device to stop/resume transmitting data. This is 

often referred to as Software Flow Control. 
YooHoo See FTS-6 
ZedZap A variant of the Zmodem file-transfer protocol. 
Zmodem A full streaming file-transfer protocol with optional 7-bit transparency and variable size data frames, designed 

and placed in the public domain by Omen Technologies, Inc. under contract for Telenet Corporation. 
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Appendix B: KEYBOARD REFERENCE 
This section is intended to be a keyboard reference for the Terminal. Some keys have corresponding menu options, while others do not. 

Menus 
Function Keyboard sequence 
File ALT+F 
Help ALT+H 
Line ALT+L 
Options ALT+O 
Session ALT+S 

Functions 
Function Keyboard sequence 
Capture ALT+C 
Clear screen ALT+J 
Command history ALT+U 
Conversation (chat) mode ALT+N 
Current (keyboard) macro set ALT+K 
Cursor key mode ALT+F10 
Dial (manual) ALT+M 
Dial (nodelist) ALT+D 
Disconnect ALT+X 
Download files ALT+F2 
Editor ALT+I 
Initialize modem [ML] ALT+Y 
Macro management ALT+V 
Numerical keypad NUMLOCK 
Phone directory manager ALT+P 
Profile management ALT+E 
Quit ALT+Q 
Raw (keyboard) mode SCROLLLOCK or ALT+= 
Reset on-line timer ALT+R 
Scroll back buffer ALT+B 
Send BREAK ALT+W 
Transmit ASCII file ALT+A 
Upload files ALT+F1 

Input fields 
Function Keyboard sequence 
Clear entire field CTRL+Y 
Clear field from cursor to beginning of field CTRL+HOME 
Clear field from cursor to end of field CTRL+END 
Delete character under cursor DEL (Delete) 
Delete word to right of cursor CTRL+W 
Field navigation (multi-field entry) TAB and SHIFT+TAB 
Insert/Overtype mode toggle INS (Insert) 
Move cursor left LEFT 
Move cursor left one word CTRL+LEFT 
Move cursor right (cannot move past text) RIGHT 
Move cursor right one word CTRL+RIGHT 
Move cursor to beginning of field HOME 
Move cursor to end of field END 

Other 
Function Keyboard sequence 
DOS shell ALT+Z 
Field navigation (multi-field entry) TAB and SHIFT+TAB 
Leave Terminal (exit program) ALT+Q 
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Appendix C: KEYPAD MODES 
The VT100 and VT52 terminal emulation protocols require that the cursor keys transmit different codes depending on the state of the 
remote application. Most on-line services follow the VT100 recommendation for this, but several editors and other programs have their 
own ideas of how this should be handled. 
If the numerical keypad (NUMLOCK) is enabled (see "Numerical keypad"), the white cursor keypad will transmit the numerical application 
codes for VT100/VT52. If an extended (101/102) keyboard is attached to the system, the gray cursor keys will not follow the numerical 
keypad setting. 
By using the SHIFT key together with the white cursor keypad, the setting of NumLock can be temporarily negated; i.e. if NumLock is 
enabled and you press SHIFT+UP (8), the Terminal will transmit the "up" key sequence to the remote. If NumLock is disabled and you 
press SHIFT+UP (8), the Terminal will transmit the numerical application keypad sequence for 8. 
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Appendix D: INTERACTIVE EMSI 
Interactive EMSI (IEMSI) is the term used to describe a mechanism by which an interactive client application, such as the FrontDoor 
Terminal, can establish a session with a server such as a BBS. 
IEMSI is loosely related to the EMSI protocol used by FD to establish a mail session with other mailers; the two protocols, however, share 
little other than its fundamental design and structure. 
When the Terminal has been configured to support the IEMSI protocol, it will monitor data received from the communications device for a 
specific sequence indicating that the remote system supports IEMSI. When this sequence is detected, the Terminal will attempt to establish 
an IEMSI session with the remote system. If the session is successfully established, the Terminal will have transmitted applicable 
information about the user to the remote system; the user information transmitted by the Terminal is stored in IEMSI profiles (see "Profile 
management"). 
If the phone book (see "Phone directory manager") is used to dial a remote system, a specific IEMSI profile can be automatically loaded 
by the Terminal when a connection is established. An IEMSI profile can also be selected manually by using the ALT+E shortcut. 
When an IEMSI session has been established, the Terminal will automatically invoke and close the split-screen conversation mode 
function (see "Conversation mode") when so requested by the remote system. 
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Appendix E: MOUSE SUPPORT 
Most commands and functions are accessed by using the keyboard. The Terminal does, however, feature limited mouse support as outlined 
below. 

Menus 
The mouse can be used to select a menu option and to move the selection bar. In the menu system, you can move between menus by 
clicking the LEFT mouse button when the mouse pointer is on the menu heading. Use the RIGHT mouse button to close the menu system 
(this is identical to pressing the ESC key). To select a menu option, double-click the LEFT mouse button when the mouse pointer is on the 
desired option; if the mouse pointer and selection bar are already on the desired option, a single click on the LEFT mouse button should be 
used. 
To invoke the menu system, use the LEFT and RIGHT mouse button simultaneously. If you have a 3-button mouse, you can also use the 
CENTER button to invoke the menu system. 

Prompt dialogs 
The mouse can be used to choose a response when you are prompted by the Terminal. Simply move the mouse pointer to the desired 
response and double-click the LEFT mouse button; if the mouse pointer and selection bar are already on the desired response, a single 
click on the LEFT mouse button should be used. If there is a Cancel option displayed in the dialog box, clicking the RIGHT mouse button 
will choose it and close the dialog. 

Lists 
In other lists such as the phone directory manager and the (command) history, the mouse can be used to select entries much like you would 
select a menu option using the mouse. Typically, clicking on an item in the list that is not highlighted will first highlight it, while clicking 
on an already highlighted item will select it. 
If there is a scroll bar to the right of the list, you can either click the LEFT mouse button when the mouse pointer is positioned somewhere 
on the actual bar, or when it is positioned on one of the arrows at the extreme ends of the bar. 

Scroll back buffer 
In the scroll back buffer function (see "Scroll back buffer" above), accessed with ALT+B, the mouse can be used to scroll the contents of 
the screen by clicking on the indicators to the right on the bottom status bar. 
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Appendix F: CONTACT INFORMATION 
Definite Solutions can be reached at: 
 Postal address: Definite Solutions HB 

Mailbox 1012 
S-112 73  Stockholm  
SWEDEN 

 Telephone: +46 8 6505087 (0800-1800 CET, Mon-Fri) 
 Fax: +46 8 6505071 
 BBS: +46 8 4410010 (V.34 8N1, X.75 ISDN) 

+46 8 4410011 (V.34 8N1, X.75 ISDN) 
 FidoNet: 2:201/329 

2:201/330 
 Internet: sales@defsol.se 

http://www.defsol.se/ 

Please refer to our website (above) for additional information such as the FrontDoor Developer’s Kit (FDDEV), the FrontDoor Frequently 
Asked Questions (FDFAQ) document, and more. 
 
 

mailto:sales@defsol.se
http://www.defsol.se/
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